Getting Started — for Mac user (Setting up your Robot)

Get the drivers and download the software to make your robots go!
. Programmer Driver

. Arduino Software IDE

o Ringo & Wink Software Libraries

Driver Installation

To prepare your computer to write code for your Wink and Ringo robots, you will need to perform the
following steps. Install the Driver for the Programming Adapter

Install the Arduino Development IDE (this is the program you'll use to write your code)

Install the Ringo Library Files

Inside Arduino, select "Arduino Fio" as the board, and select the correct port in Tools>Port

Need more help?
This is a smooth process for most people, and once you have the drivers and software loaded up on
your computer, it's easy sailing as you begin to play with your robots. If you do encounter any difficulty

getting the programming process started, please Contact Us for assistance.

Driver Installation- IMPORTANT!

Before you can use the Programming Adapter to load code onto your robots, the FTDI drivers must be
installed first. Please follow the instructions on this page to download and install the correct driver for
your computer and operating system.

It is important that the FTDI drivers be installed on your computer BEFORE connecting the programmer
to your computer.


mailto:enquiries@jswerks.com?subject=Installation
mailto:enquiries@jswerks.com?subject=Installation
mailto:enquiries@jswerks.com?subject=Installation

ul Windows Driver Installation

ol
1.Download the Windows FTDI driver.
2.Run the installer as
administrator. (Right click the installer
.exe you downloaded and select "Run
as administrator" from the drop
down. It should be listed toward the
top). If not run as administrator, the
installation will likely fail.
3.0nce installation is complete, the
Plum Geek programmer may be
plugged in. Your computer should now
recognize it as a virtual com port and
assign it a com port number.

FTDI Drivers - Windows

v

-/ Mac Driver Installation

Download the Mac FTDI driver (Mac OS
10.9 and above).

Follow the Mac driver installation guide
for your version of Mac OS. You can
download the installation guide

here: (PDF)

If you have an earlier version of Mac OS
(10.3 to 10.8), you can download the
earlier version driver here: (Download)

FTDI Drivers - Mac



http://www.ftdichip.com/Support/Documents/AppNotes/AN_134_FTDI_Drivers_Installation_Guide_for_MAC_OSX.pdf
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_2_18.dmg
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/CDM/CDM21216_Setup.exe
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg
http://www.ftdichip.com/Drivers/VCP/MacOSX/FTDIUSBSerialDriver_v2_3.dmg
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= FTDIUSBSerialDriver....dmg ~

Once the file has been downloaded, you should be able to see the
“FTDIUSBSerialDriver....dmg” on the lower left of the download bar or it can be

found in the Finder >“Downloads” folder.

ece
<

| Favorites
| £3 Dropbox
E All My Files

g f“;“" Drive & FTDIUSBSerialDriver_v2_3.dmg
®) AirDrop

1 :/'-\.; Applications
[=] Desktop
| % Documents
+ 5] Learn_to_Code_Win...

. @ Downloads
) FTDIU?SeriaIDriver....dmg z

Go ahead to click on the “FTDIUSBSerialDriver....dmg”

O @ __ FTDIUSBSerialDriver_v2_3

FTDIUSBSenaykg

C D
[ Double Click )
t C

i

Double click on the “FTDIUSBSerial.pkg” icon
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& Install FTDI USB Serial Driver &

Welcome to the FTDI USB Serial Driver Installer

|

introduction zg;xval‘lrlebe guided through the steps necessary to install this
i Read Me

License

Destination Select

Installation Type

Installation

Summary

CoRsigue
Click Continue
[ ] ‘& Install FTDI USB Serial Driver a
| &~
' E;I;DI Important Information
N\ | . .
P FTDIUSBSerialDriver ReadMe
Introduction
Read Me FTDIUSBSerialDriver is an implementation of a serial driver for FTDI USB
devices on Mac OS X. It supports FT8U232AM, FT8U245AM, FT232BM,
License FT245BM, FT2232, FT232R, FT245R, FT2232H, FT4232H, FT232H and

Destination Select
Installation Type
Installation

Summary

FT X Series devices.
Revision History

v2.3.0 (26th February 2015)
Updated for 10.9 and 10.10: signed, installs to
recommended location, 64-bit only.

v2.2.18 (8th August 2012)
Avoid dropping bytes while writing in some scenarios.

v2.2.17 (24th February 2012)
Corrected issue with custom port names.
Release for Lion.

v2.2.16 (28th February 2011)
Added support for FT232H.

Print... Save... Go Back Continue

Click Continue again
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From the Software License Agreement, click Continue to proceed next step.

Introduction

i Read Me

License

‘& Install FTDI USB Serial Driver

Software License Agreement

IMPORTANT NOTICE: PLEASE READ CAREFULLY BEFORE
INSTALLING THE RELEVANT SOFTWARE: This licence agreement
(Licence) is a legal agreement between you (Licensee or you) and Future
Technology Devices International Limited of 2 Seaward Place, Centurion
Business Park, Glasgow G41 1HH, Scotland (UK Company Number SC136640)
(Licensor or we) for use of driver software provided by the Licensor (Software).

BY INSTALLING OR USING THIS SOFTWARE YOU AGREE TO THE
TERMS OF THIS LICENCE WHICH WILL BIND YOU. IF YOU DO
NOT AGREE TO THE TERMS OF THIS LICENCE, WE ARE
UNWILLING TO LICENSE THE SOFTWARE TO YOU AND YOU
MUST DISCONTINUE INSTALLATION OF THE SOFTWARE NOW.

1. GRANT AND SCOPE OF LICENCE

1.1 In consideration of you agreeing to abide by the terms of this Licence,
the Licensor hereby grants to you a non-exclusive, non-transferable, royalty free
licence to use the Software on the terms of this Licence.

12 In this Licence a "Genuine FTDI Component" means an item of
hardware that was manufactured for, and sold by, the Licensor or a member of
the Licensor's group of companies. It does not include any counterfeit or fake
products.

Print... Save... Go Back Contique

To continue installing the software you must agree to the terms of
the software license agreement.

Read License

Click Agree to continue or click Disagree to cancel the installation and
i quit the Installer.

Disagree Agree

Click Continue

Click Agree to
proceed
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Go ahead to click Install

@

@ FTDI

& Chip
Introduction
Read Me
License
Destination Select

Installation Type

‘e Install FTDI USB Serial Driver
Standard Install on “Macintosh HD”

This will take 278 KB of space on your computer.

Click Install to perform a standard installation of this software
on the disk “Macintosh HD”.

Change Install Location...

Go Back Ins{ill |

Click Install

Once the installation of the Mac FTDI driver is successful, go ahead and close it.

@

& FTDI

& Chip
Introduction
Read Me

License

Destination Select

Installation Type
Installation

Summary

‘e Install FTDI USB Serial Driver

The installation was completed successfully.

The installation was successful.

The software was installed.

Installation of the Driver Completed

=

Click Close



ARDUTHO Arduino IDE Installation

Arduino is the program you will use to actually write code for your robots. It is kind of like a text editor or
word processor for computer code. Arduino includes its own compiler that runs in the background, so no
additional tools are required.

Download Arduino for your Operating System

Windows installer
Windows ziP file for non admin install

ARDUINO 1.6.9

The open-source Arduino Software (IDE) makes it easy to
write code and upload it to the board. It runs on
Windows, Mac OS5 X, and Linux. The environment is
written in Java and based on Processing and other open-
source software.

This software can be used with any Arduino board.

Refer to the Getting Started page for Installation
instructions.

Mac OS X107 Lion or newer

Linux 32 bits
Linux 64 bits
Linux ARM (experimental)

© O

Release Notes
Source Code
Checksums.

You will want to use Arduino version 1.6.5 or later.

Visit the Arduino Software Download page and grab the correct version for your operating system.

Software

Arduino IDE

O

Once you are at the Arduino Home page, go ahead to click “Mac OS X 10.7 Lion or newer”
Download the Arduino Software

Windows installer
Windows zIP file for non admin install

The open-source Arduine Software (IDE) makes it easy to
write code and upload it to the board. It runs an
Windows, Mac O5 ¥, and Linux. The environment is

Mac OS X107 Lion or newer

written in Java and based on Processing and other open-
source software.

This software can be used with any Arduino board.
Refer to the Getting Started page for Installation
instructions.

CONNECT, COLLABORATE, CREATE. Learn more about the Create platform.

Linux 32[&

Linux 64 bits
Linux ARM (experimental)

Release Notes
Source Code
Checksums

Try out the new

Arduino Web Editor



https://www.arduino.cc/en/Main/Software
https://www.arduino.cc/en/Main/Software

It will lead you to this page. If you would like to make a donation to support the
Arduino Software, go ahead and click “Contribute and Download”. Otherwise, click
“Just Download”.

Support the Arduino Software

Consider supporting the Arduino Software by contributing to its development. (US tax payers, please note this contribution
is not tax deductible). Learn more on how your contribution will be used.

SINCE MARCH 2015, THE ARDUINO IDE HAS BEEN DOWNLOADED
TIMES. IMPRESSIVE! THIS IDE IS NO LONGER JUST FOR
ARDUINO AND GENUINO BOARDS. HUNDREDS OF COMPANIES AROUND THE
WORLD ARE USING IT TO PROGRAM THEIR DEVICES, INCLUDING
COMPATIBLES, CLONES, AND EVEN COUNTERFEIT. YOU CAN HELP
ACCELERATE THE DEVELOPMENT OF THE ARDUINO IDE BY CONTRIBUTING
TOWARDS THE EFFORT OF MAKING IT BETTER.

$3 $5 $10 $25 $50 OTHER

JUST DOWNLOAD CONTRIBUTE & DOWNLOAD

Click Here

Once the file has been downloaded, you should be able to see the “ardunio-1.6.9-
macos.zip” on the lower left of the download bar, or it can be found in the
Finder>“Downloads” folder.

eve
<

Favorites

%} Dropbox

a — & All My Files

¥ arduino-1.6.9-macosx (1).zip ~ & iCloud Drive
d @ AirDrop

1 :/'-\; Applications
[ Desktop

M Documents

+ [ Learn_to_Code_Win...
i 0 Downloads

" arduino-1 .6.9-macosx.zip

Go ahead to click on the “ardunio-1.6.9-macos.zip” to unzip.



Next, proceed to Finder >“Downloads” folder, you will see the Arduino file
with the icon.

o0 e
<

Favorites
£2 Dropbox
E All My Files
¢ iCloud Drive
@ AirDrop
#>; Applications
Desktop
[ Documents
Learn_to_Code_Win...
© Downloads > Arduino

You may drag and drop it in the “Applications” folder

| NN = Applications
< Lo 3
Favorites ~  Date Modified
<3 Dropbox ABBYY FineReader Express 13 Jan 2015 8:47
) ABBYY FineReader for ScanSnap 8 Feb 2013 4:03 :
£ All My Files
& App Store 30 Mar 2015 11:4
¢ iCloud Drive Arduino 10 May 2016 11:
@ AirDrop g Automator 30 Mar 2015 11:4
Calculator 30 Mar 2015 11:4
7% Applications Calendar 30 Mar 2015 11:4
] Desktop » [ CardMinder 13 Jan 2015 8:27
[ Documents <& Chess 30 Mar 2015 11:4
B Contacts 30 Mar 2015 11:4
3 Learn_to_Code_Win... @ Dashboard 10 Sep 2014 6:0%
© Downloads @ Dictionary 30 Mar 2015 11:4
%% Dropbox Yesterday 9:16 pr
Sl Z DVD Player 30 Mar 2015 11:4
(© Remote Disc » [ Epson Software 13 Jan 2015 7:21

L FaceTime 30 Mar 2015 11:4
[ =4

Pacs Bl AR AA~. ANAE 44.4

Shared



L] Duino Kids

To make it quicker to launch the Arduino IDE, you may drag and drop it in
the dock on you Mac. (see below)

[ NON ) [# Applications
< 2e 0oy ZEv v M aQ 2 > RN
Favorites Name ~  Date Modified
g Dropbox @& ABBYY Fin...er Express 13 Jan 2015 8:47 pm
X » (@ ABBYY Fin...ScanSnap 8 Feb 2013 4:03 am
E All My Files
@ App Store 30 Mar 2015 11:43 pm
 iCloud Drive Arduino 10 May 2016 11:27 am
@) Airbrop ¢ Altomator 30 Mar 2015 11:43 pm
- T Cdlculator 30 Mar 2015 11:43 pm
7% Applications 7\ calendar 30 Mar 2015 11:43 pm
] Desktop » (2 CardMinder 13 Jan 2015 8:27 pm
Bﬁ e <& Chess 30 Mar 2015 11:43 pm
B Contacts 30 Mar 2015 11:43 pm
5 Learn_to_Code_Win... @ Dashbbard 10 Sep 2014 6:03 am
o Downloads ‘ Dictionary 30 Mar 2015 11:43 pm
%% Dropbox Yesterday 9:16 pm
Devices “ DVD Player 30 Mar 2015 11:43 pm
Remote Disc > [] Epson Software 13 Jan 2015 7:21 pm
FA recaTioaea AN RAme ANAL 4440 mn

800 90l '@l % glalic ™ @@ ouudJ
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A Go ahead and launch the Arduino IDE software

H

00
R

Click icon to
launch

Once opened. It should look like this.

| NON | sketch_jun09a | Arduino 1.6.9

sketch_jun09a

void setup() {
// put your setup code here, to run once:

}

void loop() {
// put your main code here, to run repeatedly:

Arduino/Genuino Mega or Mega 2560, ATmega2560 (Mega 2560) on /dev/cu.ushserial-DNO1B1AG

11



Locate the” Arduino folder” inside “Documents folder”

L NON )
<
Favorites
t} Dropbox
B Al My Files
& iCloud Drive Click and you will find a
@) AirDrop libraries folder
:I'-\-: Applications
) Desktop
@ Documents —» | p» | | Arduino
£ Learn_to_Code_Win...
0 Downloads Name
b [ libraries

Open the “Arduino” folder and you will find a libraries folder created. The next step
is to install the “Ringo” software libraries into the “Arduino Libraries” .Go ahead to
quit the Arduino software

@® sketch_jun09a | Arduino 1.6.9

void setup() {
// put your\setup code here, to run once:

) Click to close
void loopQ) { ArduniO

// put your main code here, to run repeatedly:

Arduino/Genuino Mega or Mega 2560, ATmega2560 (Mega 2560) on /dev/cu.usbserial-DNO1B1AG
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Install Ringo Software Libraries

The software libraries include code you'll add to your Arduino installation. This only needs to be done one

time. Arduino will use these library files as necessary automatically after they are installed.

1) Download a zip archive including all the Ringo library files (also use these same files for Wink) or Click on
the icon below:

Libraries

Ringo Libraries

2) Copy the three folders included in this zip file into your Arduino/libraries folder:

For the examples to compile, these three important folders must be copied into your libraries
folder: Adafruit_NeoPixel, RingoMsTimer2, and RingoWire

You'll need to re-start the Arduino software for it to see the new libraries.

The "libraries" folder is located inside the folder where your computer saves Arduino sketches.

== Windows Library Location: wv Mac Library Location:
My Documents\Arduino\libraries Documents/Arduino/libraries
After copying the paths should look like this: After copying the paths should look like this:
My Documents\Arduino\libraries\Adafruit_NeoPixel Documents/Arduino/libraries/Adafruit_NeoPixel
My Documents\Arduino\libraries\RingoMsTimer2 Documents/Arduino/libraries/RingoMsTimer2
My Documents\Arduino\libraries\RingoWire Documents/Arduino/libraries/RingoWire

Arduino libraries installation

For more information or help regarding library installation, check out the "Libraries" page on the official
Arduino site:
https://www.arduino.cc/en/Guide/Libraries

13


https://github.com/plumgeek/PlumGeek-Ringo-Robot/raw/master/ringo_libraries/RingoLibraries_Rev01-01.zip
https://www.arduino.cc/en/Guide/Libraries
https://github.com/plumgeek/PlumGeek-Ringo-Robot/raw/master/ringo_libraries/RingoLibraries_Rev01-01.zip

-

Once the file has been downloaded, you should be able to see the
“RingoLibraries_Rev01.....zip"” on the lower left of the download bar or it can be
found in the “Downloads” folder.

i RingoLibraries_Rev01-....zip ~ i RingoLibrqties_RevO1—01.zip

»

Go ahead to click on the “RingolLibraries_Rev01.....zip
Once you’ve unzipped the folder, you will see the following three folders from the
"Downloads” folder:

L N
<

Favorites
:,3 Dropbox
& Al My Files
¢ iCloud Drive
@ AirDrop
73 Applications
&2 Desktop
@ Documents
1 Learn_to_Code_Win...
© Downloads E—

v RingoLibraries_Rev01-01
| 2 Adafruit_NeoPixel
> RingoMsTimer2
| 4 RingoWire

14



Drag and drop/ copy the three files into the Arduino libraries folder.

Name

b | _ libraries

Adafruit_NeoPixel
RingoMsTimer2

complete installation process.

Once the files is inside the “Arduino Libraries” folder, you are done with the

Name @ @ [ libraries
v [ Arduino < =Y = [N
v [ libraries Favorites Name ~
> || Adafruit_NeoPixel g Dropbox » [ Adafruit_NeoPixel
" readme.txt B Al My Fil " readme.txt
> RingoMsTimer2 y riies [ 2 RingoMsTimer2
» [ RingoWire D iCloud Drive > RingoWire
@ AirDrop
#3: Applications
[ Desktop

M Documents
= Learn_to_Code_Win...
0 Downloads

Devices

15



|;| Duino Kids

Programming your Robot

Follow the steps and get yourself familiar with how to load the program sketch into your robot.

Windows Mac

Windows user Mac user

16
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[ Duino Kid

Once the button is clicked, it will lead you to the following page

Wink Demo

There is four fun demo software for you to get your robot up and running. These are called Arduino code files
(sketches). You may use the “Base Sketch” as a template to begin writing your code. If you are already familiar with
writing some basics, go ahead to explore your creativity or modify the other code examples to learn and have a better
understanding.

Base Sketch Use the Base Sketch to begin writing your own code.
The project automatically includes the supporting tabs @

that include Wink's background functions.

Pre-Loaded Demo This is the code that was loaded on your Wink when it was
shipped. The basic behaviours include the Wink Dance,
Barrier and Object Avoidance, and Light Seeking. You can
index between the three behaviours by pressing the BTN @

button on the robot.

Drive with IR Remote This demo allows you to drive an IR equipped Wink with the
optional remote control. Use this sketch as a basis for making
your own remote control triggered behaviours.

o

ZOMBIE Wink! This is a fun behaviour we created for Arduino Day 2016. Load
this on two or more Wink robots and watch the Zombie
Apocalypse happen!

o]

Click this icon to download the
“Pre-Loaded Demo*

17


http://files.plumgeek.com/software/wink/Wink_PreLoadedDemo.zip

-

Once the file has been downloaded, you should be able to see the
“Wink_PreLoadedDemo.zip” on the lower left of the download bar or it can be found

in the “Downloads” folder.

J Wink_PreLoadedDemo.zip ~

0( ® Click to open the unzip the file

| Favorites

*S
+* Dropbox

E All My Files
& iCloud Drive b \
© Ardrop | Wink_PrelLoadedDemo.zip
#3: Applications
(] Desktop
Documents R
2 e te Code W Or unzip it from the downloads
earn_to_Coae_Wwin...
© Downloads folder

Once the compressed folder is unzipped, you should be able to see the
Wink_PreLoadedDemo folder.

| NN
<

| Favorites
:} Dropbox
E Al My Files
& iCloud Drive
@ AirDrop
#3: Applications
) Desktop
@ Documents
[ Learn_to_Code_Win...
© Downloads — | Wink_PreLoadedDemo_Rev01

18



Create a new folder in the Arduino folder and name it as “demo software”

0@
<

v | | Arduino
b | demo software
b | libraries

And it should look like this.

3 = [lfiag:

o

[=]
8
<

; Arduino.

)

Favorites

:} Dropbox
£ All My Files

¢ iCloud Drive
@ AirDrop
:/‘-\.: Applications
] Desktop
@ Documents

Name

» | | demo software
» || libraries

Ifl Learn_to_Code_Win...

o Downloads

19



From the Downloads folder, copy the folder of the
“Wink_PreLoadedDemo” and paste it inside the demo software folder
which you have just created.

'@ Downloads
' a

8

olo
<

¥
<

2 B 1o =

Name

» BB Wink_PreLoadedDemo_Rev01
b Wink_PreLoadedDemo.zip

Copy and paste or drag and drop inside here.

| BON o [ Arduino

< 2l = [ CTREE 1
Favorites Name

g Dropbox » [ 7 demo software

B Al My Files > Wl libraries

¢ iCloud Drive

@ AirDrop

/> Applications

=] Desktop

Bﬁ Documents

£ Learn_to_Code_Win...

0 Downloads

demo software

ol = EPETIE Once done, the

Hame ~ “Wink_PreLoadedDemo” folder

> Wink_PreLoadedDemo_Rev01 ShOUId be inside the ”demo
software’ folder.

20
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l—' Go ahead and re-launch the Arduino IDE software

00
R

Click icon to
launch

Once opened. It should look like this.

| NON | sketch_jun09a | Arduino 1.6.9

sketch_jun09a

void setup() {
// put your setup code here, to run once:

}

void loop() {
// put your main code here, to run repeatedly:

Arduino/Genuino Mega or Mega 2560, ATmega2560 (Mega 2560) on /dev/cu.ushserial-DNO1B1AG

21



Connecting your Robot

Ensure that you have all these items on hand. Wink robot, programming adapter and
(A USB) to (B mini) USB cable.

Connect the (B mini) USB cable to the programming adaptor.

22
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Now connect the ten pins supplied cable to the robot .

I IMPORTANT Ensure that the orientation of the ten pins cable is
correctly aligned and not twisted!

23
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Ensure all the ten pins is properly inserted into the connector of the robot.

Next, connect the USB cable to your Mac.




i

You should see the LED lighted up on the robot and is on charging mode.

From the Arduino IDE, go to “Tools” > Board: select “Arduino Fio”

® Arduino File Edit Sketch Help

[ NON ) sketch_jun09a |/  Auto Format 8T
Archive Sketch
Fix Encoding & Reload
sketch_jun09a Serial Monitor 8M
void setupQ) { Serial Plotter r38L
// put your setup code here, to rur Boards Manager...
} Port >
Get Board Info .
void loop() Arduino Yun
// put your main code here, to run  Programmer: "AVRISP mkil" > Arduino/Genuino Uno
. Burn Bootloader Arduino Duemilanove or Diecimila
} Arduino Nano

Arduino/Genuino Mega or Mega 2560
Arduino Mega ADK

Arduino Leonardo

Arduino/Genuino Micro

Arduino Esplora

Arduino Mini

Arduino Ethernet

Arduino BT

LilyPad Arduino USB
LilyPad Arduino
Arduino Pro or Pro Mini
Arduino NG or older
Arduino Robot Control
Arduino Robot Motor
Arduino Gemma

Arduino Fio on /dev/cu.usbserial-DNO1B1AG




[ Duino Kids
From “Tools” again point to > Port: and you will see “/dev/cu.usbserial-DNO1AA11".
If you don’t see any port available, try disconnecting the USB and reconnect again.

(This is a common problem, and it’s normal where the computer needs to refresh to
detect the port)

& Arduino File Edit Sketch Help

o0 e sketch_jun09a |4  Auto Format ®T
Archive Sketch

Fix Encoding & Reload
sketch_jun09a Serial Monitor 38M
void setup() { Serial Plotter 8L

// put your setup code here, to rut q .
puty P Board: "Arduino Fio"

Serial ports

Get Board Info /dev/cu.Bluetooth-Incoming-Port
/dev/cu.Bluetooth-Modem
/dev/cu.usbserial-DNO1AA11

}

void loop() {
// put your main code here, to run  Programmer: "AVRISP mkll* >
Burn Bootloader

}

Now, your Arduino IDE setup is ready to download sketches to the robot.
Point to File > Sketchbook > demo software > Click “Wink_PreLoadedDemo”

@ Arduino [ Edit Sketch Tools Help

Sketchbook > Wink_PreLoadedDemo_Rev01

void setup() {
// put your ¢ Close ze:
Save
}

Save As...

void loopQ) [l Page Setup
// put your n Print

A
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A new Arduino IDE window will open with the entire “Wink_PreLoadedDemo”
sketch.

@ Arduino File Edit Sketch Tools Help

#include "WinkHardware.h"

Sketch uses 6,858 bytes (22%) of program storage space. Maximum is 3@
7 Global variables use 253 bytes (12%) of dynamic memory, leaving 1,795

Arduino Fio on /dev/cu.usbserial-DNO1AA11

Turn on your robot by pushing the Power Button as shown. The LED next to the
power button should be lighted up.

27



Click the arrow button to upload the sketch to your robot.

@ Arduino File Edit Sketch Tools Help
[ oK )

Winkeﬁhnmn Daunt

Click here

Wink_PrelLoadedDemo_Rev01 | Arduino 1.6.9

ng. You can use th

e behaviors at any time

#include "WinkHardware.h"

Arduino Fio o v/cu.usbserial-DNO1AALL

While the program is uploading the sketch, you will see the blue progress bar at the
bottom right of the Arduino IDE.

@ Arduino File Edit Sketch Tools Help
[ BON ] Wink_PreLoadedDemo_Rev01 | Arduino 1.6.9

Wink_PreLoadedDemo_Rev01l

vin King and

LLC

nfo

o learn about

#include "WinkHardware.h"

Arduino Fio on /cu.usbserial-DNO1AA11




The LED on the programming adaptor should be blinking while
uploading is in progress.

- Once completed, you will hear a short beep on the robot and it
will show “Done uploading” at the bottom of the Arduino IDE.
Congratulation! You have successfully uploaded the sketch on
your robot. Enjoy and Have Fun!

@ Arduino File Edit Sketch Tools Help
® @ Wink_PreLoadedDemo_Rev01 | Arduino 1.6.9

Wink_PreLoadedDemo_Rev01

#include "WinkHardware.h"

Arduino Fio on /dev/cu.usbserial-DNO1AA11
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